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1. Related Manuals 
 

The table below lists the manuals related to this document.  

To ensure system safety, make sure to always read and heed the information provided in all 

Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device which is used in the system.  

 

Man. No.  Model Manual name 

W500 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Hardware User's Manual 

W501 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Software User's Manual 

W505 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Built-in EtherCAT Port User's 

Manual 

W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 Operation Manual 

EX※※ 

-OMR1006 

EX180-SEC5-X23[] SI unit for EtherCAT Operation Manual 
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2. Terms and Definitions 
 

Term Explanation and Definition 

PDO communications

(Communications 

using Process Data 

Objects) 

This method is used for cyclic data exchange between the master unit 

and the slave units.  

PDO data (i.e., I/O data that is mapped to PDOs) that is allocated in 

advance is refreshed periodically each EtherCAT process data 

communications cycle (i.e., the period of primary periodic task).  

The NJ-series Machine Automation Controller uses the PDO 

communications for commands to refresh I/O data in a fixed control 

period, including I/O data for EtherCAT Slave Units, and the position 

control data for the Servomotors.  

It is accessed from the NJ-series Machine Automation Controller in the 

following ways : 

・With device variables for EtherCAT slave I/O 

・With Axis Variables for Servo Drive and encoder input slaves to which 

assigned as an axis 

SDO 

Communications 

(Communications 

using Service Data 

Objects) 

This method is used to read and write the specified slave unit data from 

the master unit when required.  

The NJ-series Machine Automation Controller uses SDO 

communications for commands to read and write data, such as for 

parameter transfers, at specified times.  

The NJ-series Machine Automation Controller can read/write the 

specified slave data (parameters and error information, etc.) with the 

EC_CoESDORead (Read CoE SDO) instruction or the 

EC_CoESDOWrite (Write CoE SDO) instruction.  

Slave unit There are various types of slaves such as Servo Drives that handle 

position data and I/O terminals that handle the bit signals.  

The slave unit receives output data sent from the master, and sends 

input data to the master.  

Node address A node address is an address to identify a unit connected to EtherCAT. 

ESI file 

(EtherCAT Slave 

Information file) 

The ESI files contain information unique to the EtherCAT slaves in XML 

format.  

Installing an ESI file enables the Sysmac Studio to allocate slave 

process data and make other settings.   

 



3．Precautions 

 

3. Precautions 
 

(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing safety 

circuit in order to ensure safety and minimize risks of abnormal occurrence.  

(2) To ensure system safety, always read and heed the information provided in all Safety 

Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 

conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part or the whole of this 

document without the permission of OMRON Corporation.  

(5) The information contained in this document is current as of October 2013. It is subject to 

change without notice for improvement.  

 
The following notations are used in this document.  

 

Indicates a potentially hazardous situation which, if not avoided, 
will result in minor or moderate injury, or may result in serious 
injury or death. Additionally there may be significant property 
damage. 

 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or property damage. 

 
 

Precautions for Safe Use 

Precautions on what to do and what not to do to ensure safe usage of the product.  

 

 

Precautions for Correct Use  

Precautions on what to do and what not to do to ensure proper operation and performance. 

 

Additional Information  
Additional information to read as required.  

This information is provided to increase understanding or make operation easier.  

 
Symbols 
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4. Overview 
 

This document describes the procedure for connecting SI Unit for Solenoid Valve 

(EX180-SEC5-X23[], hereinafter referred to as SI Unit) of SMC Corporation (hereinafter 

referred to as SMC) to NJ-series Machine Automation Controller (hereinafter referred to as 

Controller) of OMRON Corporation (hereinafter referred to as OMRON) via EtherCAT and 

provides the procedure for checking their connection. 

Refer to Section 6 EtherCAT Settings and Section 7. EtherCAT Connection Procedure to 

understand the setting method and key points to operate PDD communications of EtherCAT.  
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5. Applicable Devices and Device Configuration 
 

5.1. Applicable Devices 

The applicable devices are as follows:  

 

Manufacturer Name Model 

OMRON NJ-series CPU Unit NJ501-[][][][] 

NJ301-[][][][] 

SMC SI Unit EX180-SEC5-X230 

EX180-SEC5-X231 

SMC Solenoid Valve SJ2000/3000 series 

S0700 series 

 

Precautions for Correct Use  

As applicable devices above, the devices with the models and versions listed in Section 5.2. 

are actually used in this document to describe the procedure for connecting devices and 

checking the connection.  

You cannot use devices with versions lower than the versions listed in Section 5.2.  

To use the above devices with versions not listed in Section 5.2 or versions higher than those 

listed in Section 5.2, check the differences in the specifications by referring to the manuals 

before operating the devices.  

 

Additional Information 
 

This document describes the procedure to establish the network connection. Except for the 

connection procedure, it does not provide information on operation, installation or wiring 

method. It also does not describe the functionality or operation of the devices. Refer to the 

manuals or contact the device manufacturer.  

(SMC Corporation http://www.smcworld.com/en/ ) 

This URL is the latest address at the time of this document creation. Contact each device 

manufacturer for the latest information.  
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5.2. Device Configuration 

The hardware components to reproduce the connection procedure of this document are as 

follows: 

 

 

 

 

 

 

 

 

 

 

NJ501-1500 
EX180-SEC5-X230 
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Manufact
urer 

Name Model Version 

OMRON CPU Unit 
(Built-in EtherCAT port) 

NJ501-1500 Ver.1.06 

OMRON Power Supply Unit NJ-PA3001  
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.07 
- Personal computer  

(OS : Windows 7) 
-  

- USB cable  
(USB 2.0 type B connector) 

-  

OMRON Ethernet cable (with industrial 
Ethernet connector) 

XS5W-T421-[]M[]-K  

SMC SI Unit EX180-SEC5-X230 Rev : 
0x00010001

SMC Solenoid Valve S0721-5  
- 24VDC power supply -  
SMC ESI file SMC EX180-SEC5-x_V11.xml  

 

Precautions for Correct Use  

Prepare the applicable ESI file beforehand. The latest ESI file can be downloaded from the 

following website. 

(SMC Corporation http://www.smcworld.com/en/ ) 

Contact SMC Corporation if the file is not available. 

 

Precautions for Correct Use  

The connection line of EtherCAT communication cannot be shared with other Ethernet 

networks.  

Do not use devices for Ethernet such as a switching hub.  

Use the cable (double shielding with aluminum tape and braiding) of Category 5 or higher, 

and use the shielded connector of Category 5 or higher.  

Connect the cable shield to the connector hood at both ends of the cable.  

 

USB cable 

(Built-in EtherCAT port) 

Ethernet cable 

Personal computer 
 (Sysmac Studio installed, 
OS: Windows 7 ) 
 

+S0721-5 

24VDC 
power supply 

 

http://www.smcworld.com/en/


5．Applicable Devices and Device Configuration 

 

Precautions for Correct Use  

Update the Sysmac Studio to the version specified in this section or higher version using the 

auto update function.  

If a version not specified in this section is used, the procedures described in Section 7 and 

subsequent sections may not be applicable. In that case, use the equivalent procedures 

described in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

Additional Information  
For information on the specifications of the Ethernet cable and network wring, refer to Section 

4 EtherCAT Network Wiring of the NJ-series CPU Unit Built-in EtherCAT Port User's Manual 

(Cat. No. W505).  

 

Additional Information  
The system configuration in this document uses USB for the connection to the Controller. For 

information on how to install a USB driver, refer to A-1 Driver Installation for Direct USB Cable 

Connection of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  
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6. EtherCAT Settings 
 

This section describes the specifications such as communication parameters and variables 

that are defined in this document.  

Hereinafter, the SI Unit is referred to as the "Destination Device" or the "Slave Unit" in some 

descriptions.  

 

 

6.1. EtherCAT Communications Parameter Settings 

The communications parameter required to connect the Controller and the Destination Device 

via EtherCAT is given below.  
 

 SI Unit 

Node address 1 

 

 

6.2. Allocation for PDO Communications 

The EtherCAT PDO communications data of the Destination Device are allocated to the 

Controller's device variables. The device variables and the data types are shown below.  
 
■Output area (Controller → Destination Device) 

Device variable name Data type Meaning 

E001_Valve_Control_Valves_0_to_7_6001_01 BYTE 
Digital output value 

(in units of 1 byte) 

 E001_Valve_0 BOOL Output bit 00 

 E001_Valve_1 BOOL Output bit 01 

 E001_Valve_2 BOOL Output bit 02 

 E001_Valve_3 BOOL Output bit 03 

 E001_Valve_4 BOOL Output bit 04 

 E001_Valve_5 BOOL Output bit 05 

 E001_Valve_6 BOOL Output bit 06 

 E001_Valve_7 BOOL Output bit 07 

E001_Valve_Control_Valves_8_to_15_6001_02 BYTE 
Digital output value 

(in units of 1 byte) 

 E001_Valve_8 BOOL Output bit 08 

 E001_Valve_9 BOOL Output bit 09 

 E001_Valve_10 BOOL Output bit 10 

 E001_Valve_11 BOOL Output bit 11 

 E001_Valve_12 BOOL Output bit 12 

 E001_Valve_13 BOOL Output bit 13 

 E001_Valve_14 BOOL Output bit 14 

 E001_Valve_15 BOOL Output bit 15 
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E001_Valve_Control_Valves_16_to_23_6001_03 BYTE 
Digital output value 

(in units of 1 byte) 

 E001_Valve_16 BOOL Output bit 16 

 E001_Valve_17 BOOL Output bit 17 

 E001_Valve_18 BOOL Output bit 18 

 E001_Valve_19 BOOL Output bit 19 

 E001_Valve_20 BOOL Output bit 20 

 E001_Valve_21 BOOL Output bit 21 

 E001_Valve_22 BOOL Output bit 22 

 E001_Valve_23 BOOL Output bit 23 

E001_Valve_Control_Valves_24_to_31_6001_04 BYTE 
Digital output value 

(in units of 1 byte) 

 E001_Valve_24 BOOL Output bit 24 

 E001_Value_25 BOOL Output bit 25 

 E001_Valve_26 BOOL Output bit 26 

 E001_Valve_27 BOOL Output bit 27 

 E001_Valve_28 BOOL Output bit 28 

 E001_Valve_29 BOOL Output bit 29 

 E001_Valve_30 BOOL Output bit 30 

 E001_Valve_31 BOOL Output bit 31 
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7. EtherCAT Connection Procedure 
 

This section describes the procedure for connecting the Controller to the SI Unit via EtherCAT.  

This document explains the procedure for setting up the Controller and the SI Unit from the 

factory default setting. For the initialization, refer to Section 8 Initialization Method.  

 

7.1. Work Flow 

Take the following steps to perform PDO communications of EtherCAT.  

 

7.2. Setting Up the SMC SI Unit Set up the SMC SI Unit.  
  

 7.2.1. Hardware Settings Set the hardware switches on the SI Unit and wire 
the connectors.  

  
7.3. Setting Up the Controller Set up the Controller.  

  
 7.3.1. Starting the Sysmac Studio and 

Installing the ESI File 
Install the ESI file for the SI Unit in the Sysmac 
Studio.  

  
 7.3.2. Setting Up EtherCAT Network 

Configuration 
Set up the EtherCAT network configuration.  

  
 7.3.3. Setting the Device Variables Set the device variables used for the EtherCAT 

Slave Unit.  
  

 7.3.4. Transferring the Project Data Transfer the project data from the Sysmac Studio to 
the Controller.  

  
7.4. Checking the EtherCAT 

Communications 
Confirm that the PDO communications of EtherCAT 
are performed normally.  

  
 7.4.1 Checking the Connection Status Check the connection status of the EtherCAT 

network.  
  

 7.4.2 Checking the Data that are Sent 
and Received 

Confirm that the correct data are sent and received. 

 



7．EtherCAT Connection Procedure 

 

7.2. Setting Up the SMC SI Unit 

Set up the SMC SI Unit.  

 

7.2.1. Hardware Settings 
Set the hardware switches on the SI Unit and wire the connectors. 

 

Precautions for Correct Use  

Make sure that the power supply is OFF when you perform the setting up.  

 

1 Confirm that the power supply to 

the SI Unit is OFF.  

 
* If the power supply is turned 

ON, settings may not be 
applicable as described in the 
following procedure.  

 

2 Check the position of the 

hardware switches and the 

connectors on the SI Unit by 

referring to the right figure. 

 

 

 
  <Front view> 

 

 

 

    

 

<Bottom view> 

Ground terminal

Power supply for control 

EtherCAT port (IN) Power supply for 

solenoid valves 

Device ID switches
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3 Set the Device ID switches as 

follows: 

[Device ID 0x100] : 0 

[Device ID 0x10] : 0 

[Device ID 0x1] : 1 

4 Connect the Ethernet cable to 

the EtherCAT port (IN).  

 

5 Connect the 24 VDC power 

supply to both power supplies 

for control and for solenoid 

valves. 
 
Connect the ground terminal of 

the SI Unit to ground. 
 

 
 Pin No. Signal 

name 
A1 SI 24V Power supply for control 
A2 SI 0V 
B1 SV 24V Power supply for 

solenoid valves B2 SV 0V  

6 Turn ON the 24 VDC power 

supply. 

 

Ethernet 
cable 

 

Additional Information  
For specifications of wiring to the SMC SI Unit, refer to Mounting and Installation of the SI unit 

for EtherCAT Operation Manual (Cat. No. EX* * -OMR1006). 
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7.3. Setting Up the Controller 

Set up the Controller.  

 

7.3.1. Starting the Sysmac Studio and Installing the ESI File 
Install the ESI file for the SI Unit in the Sysmac Studio.  

Install the Sysmac Studio and USB driver in the personal computer beforehand.  

 

1 Connect the Ethernet cable to 

the built-in EtherCAT port 

(PORT2) of the Controller and 

the USB cable to the peripheral 

(USB) port. As shown in 5.2. 

Device Configuration, connect 

the personal computer, SI Unit, 

and Controller.  

Turn ON the power supply to the 

Controller.  

 

2 Start the Sysmac Studio.  

Click the New Project Button.  

 

* If a confirmation dialog for an 

access right is displayed at 

start, select to start.  

 

CPU Unit

USB cable End Cover

Power Supply Unit
Ethernet 
cable 
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3 The Project Properties Dialog 
Box is displayed.  
* In this document, New Project 

is used as the Project name. 
 
Confirm that the device you use 
is shown in Category and 
Device in the Select Device 
Field.  
 
 
 
 
 
 
 
Select version 1.06 from the 
pull-down list of Version.  
 
* Although 1.06 is selected in 

this document for example, 
select the version you actually 
use.  

 

 

4 Click the Create Button.  

5 The New Project is displayed.  

The left pane is called Multiview 

Explorer, the right pane is called 

Toolbox and the middle pane is 

called Edit Pane.  

6 Double-click EtherCAT under 

Configurations and Setup in 

the Multiview Explorer.  

 

Multiview 
Explorer 

Edit Pane Toolbox
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7 The EtherCAT Tab is displayed 

on the Edit Pane.  

 

8 Right-click Master and select 

Display ESI Library.  

9 The ESI Library Dialog Box is 

displayed. Click the this folder 

link.  

 

When the Explorer starts, close 

the dialog box by clicking the 

Close Button.  

10 The Explorer starts and a folder 

is opened, allowing you to install 

the ESI file. Copy the prepared 

SMC EX180-SEC5-x_V11.xml 

to this folder. 
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11 Select Exit from the File Menu 

to exit the Sysmac Studio.  

 

A dialog box is displayed 

confirming whether to save the 

project. If you do not need to 

save, click the No Button.  

 

* You need to restart the 

Sysmac Studio after installing 

the ESI file.  

 

 

12 In the same way as steps 2 to 8, 

restart the Sysmac Studio and 

display the ESI Library Dialog 

Box.  

Click the + Button of SMC 

EX180-SEC5-x_V11 to confirm 

that EX180-SEC5-X230 

Rev :0x00010001 is displayed. 

 

Confirm that an exclamation 

mark (warning) is not displayed. 

 

Click the Close Button. 

 

Precautions for Correct Use  

If an exclamation mark (warning) is displayed for the ESI file, check the name of the ESI file 

and obtain the ESI file with a correct name. If an exclamation mark (warning) is displayed 

even when the name of the ESI file is correct, the file may be corrupted. Contact the device 

manufacturer.  
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7.3.2. Setting Up the EtherCAT Network Configuration 
Set up EtherCAT network configuration with the Sysmac Studio.  

 

1 Select Communications Setup 

from the Controller Menu.  

 

2 The Communications Setup 

Dialog Box is displayed.  

Select the Direct connection via 

USB Option for Connection 

Type.  

 

Click the OK Button.  

3 Select Online from the 
Controller Menu.  
A confirmation dialog box is 
displayed. Click the Yes Button. 
 
* The displayed dialog depends 

on the status of the Controller 
used. Check the contents and 
click the Yes Button to 
proceed with the processing. 

 

 
 

 

Additional Information  
For details on online connections to a Controller, refer to Section 5 Online Connections to a 

Controller of the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

4 When an online connection is 

established, a yellow bar is 

displayed on the top of the Edit 

Pane.  
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5 Right-click Master on the 

EtherCAT Tab Page, and select 

Compare and Merge with 

Actual Network Configuration. 

 

 

 

 

 

 

 

 

A screen is displayed stating 

"Get information is being 

executed". 

 
 

 

6 The Compare and Merge with 
Actual Network Configuration 
Pane is displayed.  
 
Node address 1 and 
EX180-SEC5-X230 
Rev :0x00010001 are added to 
the Actual network configuration 
after the comparison. 
 
Click the Apply actual network 
configuration Button.  

7 A confirmation dialog box is 
displayed. Check the contents 
and click the Apply Button.  
 
 
 
 
 
 
 
 
 
 
Node address 1, E001, and 
EX180-SEC5-X230 
Rev:0x00010001 are added to 
the Network configuration on 
Sysmac Studio. 
 
 
Confirm that they were added 
and click the Close Button.  
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8 Node address 1, E001, and 
EX180-SEC5-X230 
Rev :0x00010001 are added to 
the EtherCAT Tab Page on the 
Edit Pane. 
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7.3.3. Setting the Device Variables 
Set the device variables used for the EtherCAT Slave Unit.  

 

1 Select Offline from the 

Controller Menu.  

 

 

 

 

The yellow bar on the top of the 

Edit Pane disappears.  

 
 

2 Double-click I/O Map under 
Configurations and Setup on 
the Multiview Explorer.  

 

3 The I/O Map Tab is displayed on 

the Edit Pane.  

Confirm that Node1 is displayed 

in the Position Column and the 

Slave Unit is displayed.  

 

* To manually set a variable 

name for the Slave Unit, click 

a column under the Variable 

Column and enter a name.  

4 Right-click Node1 and select 

Create Device Variable.  
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5 The variable names and 

variable types are automatically 

set.  

 

Additional Information  
The device variables are named automatically from a combination of the device names and 

the port names.  

For slave units, the default device names start with an "E" followed by a sequential number 

starting from "001" 

 

Additional Information  
In this document, device variables are automatically named for a unit (a slave). Device 

variables can also be manually named for I/O ports.  
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7.3.4. Transferring the Project Data 
Transfer the project data from the Sysmac Studio to the Controller.  

 

 

 
Always confirm safety at the Destination Device before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

Precautions for Safe Use 

After you transfer the user program, the CPU Unit restarts and communications with the 

EtherCAT slaves are cut off. During that period, the slave outputs behave according to the 

slave settings. The time that communications are cut off depends on the EtherCAT network 

configuration.  

Before you transfer the user program, confirm that it will not adversely affect the device.  

 

 

1 Select Check All Programs 

from the Project Menu.  

 

2 The Build Tab Page is displayed 

on the Edit Pane.  

Confirm that "0 Errors" and "0 

Warnings" are displayed.  

 

 

3 Select Rebuild Controller from 

the Project Menu.  

 

4 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  

5 Confirm that "0 Errors" and "0 

Warnings" are displayed in the 

Build Tab Page.  
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6 Select Online from the 

Controller Menu.  

 

7 Select Synchronization from 

the Controller Menu.  

 

8 The Synchronization Dialog Box 

is displayed.  

Confirm that the data to transfer 

(NJ501 in the right dialog) is 

selected. Then, click the 

Transfer To Controller Button. 

 

* After executing the Transfer To 

Controller, the Sysmac Studio 

data is transferred to the 

Controller and the data are 

compared.  

 

 

9 A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the Yes 

Button.  

 

A screen stating "Synchronizing" 

is displayed.  

 

 

A confirmation dialog box is 

displayed. Confirm that there is 

no problem and click the No 

Button.  

* Do not return it to RUN mode. 
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10 Confirm that the synchronized 

data is displayed with the color 

specified by "Synchronized" 

and that a message is displayed 

stating "The synchronization 

process successfully finished". 

If there is no problem, click the 

Close Button.  

 

* A message stating "The 

synchronization process 

successfully finished" is 

displayed if the Sysmac Studio 

project data and the data in 

the Controller match.  

 

* If the synchronization fails, 

check the wiring and repeat 

from step 1.  
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7.4. Checking the EtherCAT Communications 

Confirm that the PDO communications of EtherCAT are performed normally.  

 

7.4.1. Checking the Connection Status 
Check the connection status of the EtherCAT network.  

 

1 Confirm that the EtherCAT 

communications are performed 

normally by checking the LED 

indicators on the Controller.  

 

LED indicators in normal status are 

as follows: 

[NET RUN] : Lit green 

[NET ERR] : Not lit 

[LINK/ACT] : Flashing yellow 
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2 he LED indicators on the SI 

nit.  

ors in normal status are 

as

   

 

   

[L/A OUT] : Not lit   

Check t

U

 

LED indicat

 follows: 

[RUN] : Lit green  

[ERR] : Not lit   

[L/A IN] : Flickering  

 
Name  Status  iption LED Descr

OFF  Init 
Flashing Pre-Operational 
Single flash Safe-Operational 
Flickering Initialization or Bootstrap 

RUN 
(Green)

ON Operational 

ON PDI watchdog timeout 
Double flash out Application watchdog time
Single flash Unsolicited state change 
Flashing Invalid configuration 
Flickering Booting error 

ERR 
(Red)

OFF No error 

OFF IN side : No link / No activity  
ON IN side : Link / No activity  

L/A IN
(Green)

Flickering IN side : Link / Activity  

OFF OUT side : No link / No activity  

ON  OUT side : Link / No activity  
L/A OUT
(Green)

Flickering  OUT side : Link / Activity  
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7.4.2. Checking the Data that are Sent and Received 
Confirm that the correct data are sent and received.  

 

 
Always confirm safety at the Destination Device before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 
The Destination Device will run if you proceed to this section. Confirm safety 

before operation. If you cannot confirm safety, do not proceed to this section 

after completing until Section 7.4.1. If you proceed to this section, make sure to 

complete all the steps and place the Destination Device in the safe state. 

 

 

1 Select Watch Tab Page from the 

View Menu.  

 

2 The Watch Window1 Tab Page is 

displayed in the lower section of the 

Edit Pane.  

 26

3 Enter the following names in the 

Watch Window1 Tab Page for 

monitoring.  

E001_Valve_0 

E001_Valve_1 

To enter a new name, click the Input 

Name Column. 

 

4 Confirm that the Online value of 
E001_Valve_0 is False and click 
TRUE in the Modify Column. 
 
 
 
Confirm that the Online value of 
E001_Valve_0 changes to True. 
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5 Confirm that No.0 of the OUT 
Solenoid Valve turns ON 
(corresponding LED indicator is lit 
red). 

6 Click FALSE in the Modify Column 
of E001_Valve_0. 
 
Confirm that the Online value of 
E001_Valve_0 changes to False 
and No.0 of the OUT Solenoid Valve 
turns OFF (corresponding LED 
indicator is not lit). 

7 Confirm that the Online value of 
E001_Valve_1 is False and click 
TRUE in the Modify Column.  
 
 
 
 
Confirm that the Online value of 
E001_Valve_1 changes to True.  

 
 

01 23 45 67 89 10 11 12 13 14 15 16 17 
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8 Confirm that No.1 of the OUT 
Solenoid Valve turns ON 
(corresponding LED indicator is lit 
green). 

9 Click FALSE in the Modify Column 
of E001_Valve_1. 
 
Confirm that the Online value of 
E001_Valve_1 changes to False 
and No.1 of the OUT Solenoid Valve 
turns OFF (corresponding LED 
indicator is not lit). 

01 23 45 67 89 10 11 12 13 14 15 16 17 
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8．Initialization Method 

 

8. Initialization Method 
 

This document explains the setting procedure from the factory default setting.  

Some settings may not be applicable as described in this document unless you use the 

devices with the factory default setting.  

 

8.1. Initializing the Controller 

To initialize the settings of the Controller, select Clear All Memory from the Controller Menu of 

the Sysmac Studio. The Clear All Memory Dialog Box is displayed. Check the contents and 

click the OK Button.  
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9. Revision History 
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code 

Date of revision Revision reason and revision page 

01 Oct. 8, 2013 First edition 
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